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Overview

Object Viewer provides performance and diagnostic information about ApplicationObjects. You can use Object
Viewer to show performance parameters, resource consumption, and reliability measurements of objects you
select.

In addition to viewing an object’s data value, data quality, and the communication status of the object, you can
also modify some of the object’s attributes for diagnostic testing. Modifications can include adjusting timing
parameters and setting objects in an execution or idle mode.

Object Viewer runs with minimal System Platform and operating system requirements.

Using Object Viewer you can:

• View the data type, data quality, data value, timestamp, and communication status of ApplicationObject•
attributes.

• Do diagnostic testing on ApplicationObjects.•

• Modify selected ApplicationObject attributes.•

Availability
Object Viewer is a common component of any Galaxy application and is available from any workstation in the
application with a deployed WinPlatform. You do not need to install the utility on each workstation.

Starting Object Viewer
Since Object Viewer is run time tool, the galaxy must be deployed to view objects. You can use Object Viewer
from any workstation that is part of your Galaxy application.

To start Object Viewer
1. Start Object Viewer from the Windows Start menu or from within the System Platform IDE.1.

▪ Windows Start menu: Click Start, navigate to AVEVA, and click System Platform Management Console.▪

▪ System Platform IDE: Click on Monitor, located in the ribbon bar Runtime group. Or, right-click on a▪
deployed object and select Monitor from the Context menu.

2. In the console tree, expand the Platform Manager to show the list of Galaxies, and then expand a Galaxy to2.
show a list of platforms.

3. Right-click a platform, and then click Launch Object Viewer.3.
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Navigating In Object Viewer
The main window of the Object Viewer is composed of three areas:

• Console tree on the left•

• Details pane on the right•

• Watch window bottom•

The console tree works like Windows Explorer. Use the plus (+) and minus (-) signs to expand or hide the nested
list items shown in the pane. When you select an object in the console tree, its associated attributes and their
properties are shown in the details pane.

Drag a specific set of attributes of interest to a watch window to monitor their Quality, Status, Timestamp, and
Value as you manipulate them and other attributes that affect their data values. You can save the contents of a
watch window to a file for future reference.

Finding Objects
You can use the Find dialog box to search for an object in your Galaxy application.

To find an object
1. On the Edit menu, click Find Object.1.
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2. Select the Find field and enter the text you want to find.2.

3. In the Search Criteria field, select a search option (Contains, Exact match, Start with or Ends with).3.

4. In the Search Scope area, select a platform and an engine.4.

5. Under Name, select either Tagname or Hierarchical name. For more information about these names, refer5.
to the Application Server User Guide, "Using Contained Names."

6. Under Type, select either Instance or Template.6.

7. To limit the search scope, you can select either or both of the following options:7.

▪ Only objects with errors or warnings▪

▪ Only checked-out objects▪

8. Click the Find icon .8.

Closing Object Viewer
By default, when you close the Object Viewer, your settings are not saved, including the attributes you selected
for the Watch window. You can choose to save the watch windows you create. For more information about
saving watch windows, see Saving a Watch Window .

To close the Object Viewer
• On the File menu, click Exit.•
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Viewing Attributes

Using Object Viewer, you can view the attributes of all ApplicationObjects in your Galaxy application from any
workstation used in the application.

Viewing an Object’s Attribute Data
All AutomationObjects consist of attributes and common properties such as data type, initial value, and value
range. Each object’s set of attributes appears in the details pane when you select the object in the console tree.

To view an object’s attribute data
1. Start Object Viewer. Object Viewer’s main window appears. The object in focus in the IDE or Platform1.

Manager is put into focus in the console tree of the Object Viewer.

2. To view another object’s attributes, select the object in the console tree.2.

Quality
Every readable attribute is assigned a quality property that matches one of four categories.

Quality Description

Good Data is good and can be used.

Uncertain Data is questionable, but can be used.

Initializing Data is not yet available, but will be soon.

Bad Data cannot be used.

Status
The status of an ApplicationObject’s attribute describes whether a particular Read or Write request succeeded or
failed. Possible status conditions include:

Status Description

OK Operation completed successfully.
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Status Description

Pending Request is received, but is not yet complete. A
transitory status.

Warning Operation completed successfully, but with
some warning condition. Applies only to Write
actions.

Communication Error Request failed due to an error communicating
with the target ApplicationObject.

Configuration Error Request failed due to an error in configuration.

Operational Error Request failed due to an operator error.

Software Error Request failed due to an internal software error.

Security Error Request failed due to insufficient security access
rights.

Other Error All other errors.

Has Buffer
The Object Viewer Has Buffer column indicates if an attribute has a buffer property. The value displayed in the
column is True if the attribute has a buffer property or False if the attribute has no buffer property.

To view the value of the Buffer property
Use the Attribute Reference dialog box to add the buffer property to the watch list. You can either:
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• Enter the property name in the dialog box, using the syntax <attributename>.buffer.•

• Use an alternate syntax, <attributename>.property(Buffer). This syntax should be used for subscribing to•
attributes on a DI Object.

Double-click the attribute in the watch window. The View Buffer Elements dialog box appears.

The View Buffer Elements dialog box header displays the Attribute Reference, Type, Timestamp and Count. A
details window displays the Value, Timestamp, and Quality (VTQ) columns for each item.

Understanding Failed Requests
When a failure occurs during a request, the details of the error appear in a dialog box, which contains the source
of the error and a description of the error.

Communication Errors
Communication errors include the following:

Source Description Reason

Requesting NMX Request Timed Out A message was not processed in a timely
manner.
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Source Description Reason

Requesting NMX Communication Error:
Platform communication
error

Attempt to get or set an attribute from an
ApplicationObject on a remote platform with
the network down between the two platforms.

Responding NMX Communication Error:
Engine communication
error

Attempt to get or set an attribute from an
ApplicationObject on a remote engine that is
currently not running, but deployed.

Responding NMX Communication Error:
Engine communication
error

Attempt to get or set an attribute from an
ApplicationObject on a remote engine, but that
remote engine is currently undeployed while
the remote platform is deployed.

Responding
Automation Object

Index out of range Attempt to get or set an attribute from an
ApplicationObject attribute that is an array, but
specified an array index that is out of range.

Configuration Errors
Configuration errors include the following:

Source Description Reason

Responding LMX Invalid Object ID Attempt to get or set an attribute from an
ApplicationObject on a remote engine, but that
remote ApplicationObject is currently
undeployed while the remote engine is
deployed.

Requesting NMX Invalid Platform ID Attempt to get or set an attribute from an
ApplicationObject on a remote platform, but
that remote platform is currently undeployed.

Requesting LMX Invalid reference Attempt to get or set an attribute from an
ApplicationObject that is not yet configured in
the system. A bad reference.

Responding NMX Invalid Engine ID Attempt to get or set an attribute from an
ApplicationObject on a remote engine, but that
remote engine is currently undeployed while
the remote platform is deployed.

Operational Errors
Operational errors include the following:
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Source Description Reason

Responding
Automation Object

Attribute not writable Attempt to set an attribute in an
ApplicationObject that cannot be written to.

Responding
Automation Object

Write access denied. Attempt to set an attribute in an
ApplicationObject that can be written to, but
that the user cannot write to. This can be an
operational error ( the attribute is read only) or
a security error (the current user does not have
permission to write to the attribute).

Responding
Automation Object

Software error: The data to
be set was to the wrong
data type.

Attempt to set an attribute in an
ApplicationObject can be written to, but with a
data type that cannot be written to because it
cannot be coerced. For example, trying to write
a Boolean value of True to an attribute of type
QualifiedStruct or QualifiedEnum.

Sorting Data
You can sort the data shown in the details pane in either ascending or descending order by clicking any column
heading. You can show hidden attributes in the details pane by selecting the Include hidden command from the
Options menu. For example, click the Attribute Name heading to sort the list by attribute name. Attribute names
appear in ascending or descending alphabetical order.

Hidden attribute names include leading underscores and appear at the top of an ascending order list. For
example, all the attributes in the following figure are hidden attributes, including the _AdviseOnlyActiveEnabled
attribute, which indicates if Advanced Communication Management is active.
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Viewing Attributes in a Watch Window
You can use the watch window to view an attribute or a group of attributes apart from the entire list of
attributes.

The attributes in the watch window are listed by their AttributeReference, which shows which object the
attribute belongs to.

For example, the AppEngine object contains AlarmOnCnt and AlarmUnAckCnt attributes. When you add these to
a watch list, the object tag name is prepended to the reference string.

To view selected attributes in a watch list
1. Select an ApplicationObject from the console tree. A list of its attributes appears.1.

2. Add an attribute to the watch list.2.

• In the details pane, right-click an attribute to place it on the watch list. Click Add to Watch. The attribute•
in the AttributeReference format, along with its data, appears in the watch list.

• Right-click in the watch window and click Add Attribute Reference. In the Add Attribute Reference•
dialog box, type the attribute name in the following format: Object Reference.Attribute Reference. For
example, enter SystemArea.ScanState to view the ScanState attribute of the SystemArea object.

3. To add a block of attributes to the watch window, hold down the SHIFT key and click the left mouse key while3.
selecting the first and last attribute of the block.

4. To add a random list of attributes to the watch window, hold down the CTRL key and click the left mouse4.
button while selecting attributes.

Using the Aveva OPC UA Client Service
You can use an instance of the Aveva OPC UA Client Service hosted by your Galaxy to subscribe to attributes
hosted by an OPC UA server. Using an instance of the Aveva OPC UA Client Service in Object Viewer requires the
use of the specific service instance name as a prefix.

For example, using an instance of the UA Client Service with Scope Name of "OPCUAClient_010'" would be
specified as follows:

OPCUAClient_010:AppEngine.AlarmOnCnt.value

Adding a Watch Window
By default, a single watch window appears in the Object Viewer. You can add more watch windows to view
different groups of attributes or view attributes of different ApplicationObjects.

Note: If attributes already appear in the watch window, right-click away from the list of attributes to open the
correct shortcut menu.
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To add a watch window
1. Right-click in the watch window and click Add Watch Window. A new watch window appears with the1.

default tab name, Watch List 2.

2. To rename the new watch window, right-click it and click Rename Tab. Type the name of the watch window2.
in the Rename Tab dialog box and click OK.

3. Add attributes to the watch window or add another watch window.3.

4. Move from one watch window to another by clicking the tabs.4.

Saving a Watch Window
You can save a watch window and reuse it each time you start Object Viewer.

To save a watch window
1. To save a watch window, either:1.

▪ On the File menu, select either either Save (for an existing watch window file) or Save As.▪

▪ Right-click in the Watch List and select either Save (for an existing watch window file) or Save As.▪

2. When the Save As dialog box opens, select a folder path in which to save the watch window.2.

3. Click Save. The watch window is saved as an XML file.3.

Removing Attributes from Watch Windows
The attributes that you add to watch windows remain until you remove them or until you close Object Viewer.
For example, if you are viewing the attributes of an AppEngine and place some of its attributes in a watch
window, those attributes remain even when you select another object in the console tree.

Note: This action does not delete the attribute from the object. The attribute is viewable in the details pane.

To remove an attribute from a watch window
• In the watch window, right-click the attribute you want to remove and click Remove from Watch. The•

attribute is removed from the watch window.
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Modifying Attribute Values

You can modify an attribute’s value for diagnostic testing. You must have the proper security permissions to do
this and the attribute’s value must also be changeable.

Before making modifications to any attribute, you must be familiar with the attributes and their functions. Also,
you must understand the effects that changing attribute values can have on your Galaxy application.

Attribute Properties
Each data point of an attribute is associated with a unique VTQ identifier (Value, Time, and Quality). Only the
value can be modified, provided that the attribute is user-writable. When value is modified, a new VTQ is
generated.

When you try to modify an attribute value, a dialog box appears that shows the type (datatype) and current
value of the attribute. Use this information as a guide for continuing.

Before modifying an attribute value, check its category shown in the Category column to determine whether
modification is possible.

Category Property
An attribute’s Category property determines if the attribute is writable. The only categories that you can write to
are:

• Writeable_U•

• Writeable_US•

• Writeable_UC•

• Writeable_USC•

• Writeable_UC_Lockable•

• Writeable_USC_Lockable•

The letters included in the Writable categories mean the following:

Letter Description

U UserSets are OK. You can modify these in the Object Viewer.
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Letter Description

S SupervisorySets are OK. You can modify these only with an
application function. You cannot modify them in the Object
Viewer.

C Configtime time sets only. You can modify these only when you
are configuring the object. You cannot modify them in the
Object Viewer.

Value Property
You can modify the value property of an attribute shown in the Value column, if the attribute is user-writable
(see Category Property ). The datatype of the attribute is shown in the Type column, and indicates the kind of
value that you can assign to the attribute, for example, Boolean, integer, double, etc.

Timestamp Property
The timestamp of an attribute is the Time element of the VTQ packet. It represents the time of the last recorded
change to the attribute, and is shown in the Timestamp column. The Timestamp cannot be modified, or turned
on or off. An attribute will have a timestamp if the value in the Has Quality/Timestamp column is true.

Modifying an Attribute Value
You can only modify attribute values if you have the proper privileges and the attribute is writable. Check the
Category value in the details pane for the attribute you want to modify. You cannot modify Calculated and
SystemWriteable attributes.

Some attribute values affected by the changed attribute are updated only after you select the attribute. For
example, an object’s ScanStateCmd controls the object’s scan state, with True being OnScan, False being OffScan.
The object also has a ScanState attribute that indicates the current scan state of the object.

Assuming ScanStateCmd and ScanState are False, change ScanStateCmd to True. Notice that the object’s
ScanState attribute value remains False. Select the ScanState attribute. Its value changes to True.

To modify an attribute value
1. Select the object that contains the attribute you want to change.1.

2. Right-click the attribute and click Modify. A Modify <data type> Value dialog boxes appears, related to the2.
data type for the selected attribute.
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3. Modify the values as needed.3.

4. Click Apply and click OK. The new value appears in the Value column of the details pane for that attribute.4.

Modifying an Attribute from the Watch Window
You can change an attribute’s value while in a watch window.

Important: Attributes in the watch window update immediately. Attributes in the details pane update when you
click them.

To modify an attribute from the watch window
1. In the watch window, double-click the attribute. A dialog box related to the attribute’s data type appears.1.

2. If the attribute is writable, enter or select the new value for the attribute.2.

3. Click Apply and click OK. The new value appears in the Value column of the watch window for that attribute.3.

Viewing Changes Dynamically
Attribute values shown in the details pane are static. You must click on an attribute in the details pane to update
the display.

You may have a configuration in which the Galaxy Repository node was upgraded, but other nodes were not
upgraded. If you use ObjectViewer on the upgraded node to view information for attributes from a non-
upgraded node, the time stamps should not be considered as valid source times. In this case, the time stamps
reflect the time of the local node (the one running ObjectViewer) for the attributes running on the non-upgraded
node.

Attribute values shown in the watch window are updated immediately when the attribute’s value changes.

For example, objects have two common attributes, ScanStateCmd and ScanState. ScanStateCmd controls the
scan state of the object (OnScan or OffScan). ScanState shows the last known scan state of the object.

If you place the ScanState attribute in a watch window and change the ScanStateCmd attribute in the details
pane, the ScanState attribute is updated immediately. Instead, if you place the ScanStateCmd attribute in a
watch window, leave the ScanState attribute in the details pane, and then change the value of ScanStateCmd,
the ScanState attribute is not updated until you select it in the details pane.
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Setting an ApplicationObject OnScan
The OnScan state indicates the object’s run-time state, which means it is performing its normal processing as
part of its execute method.

When setting AppEngines OnScan:

• The hosting WinPlatform’s status must also be OnScan.•

• Any object hosted on the AppEngine is automatically set OnScan.•

To set an ApplicationObject OnScan
1. Select the object in the console tree.1.

2. In the details pane, right-click the ScanStateCmd attribute and click Modify. The Modify Boolean Value2.
dialog box appears.

3. Assuming the current value is False (OffScan), click True, click Apply, and then click OK.3.

Note that the ScanState attribute’s value in the details pane remains False (OffScan).

4. To update the display, click the ScanStateCmd attribute.4.

Setting an ApplicationObject OffScan
OffScan is the run-time state that indicates that an object is idle and not ready to run.

Because WinPlatforms host AppEngines, you must ensure that all AppEngines hosted by the WinPlatform are
OffScan before setting the WinPlatform OffScan. An error message appears if you try to set a WinPlatform
OffScan while its hosted AppEngines are still OnScan.

Although AppEngines host other objects, it is not necessary for all the objects to be OffScan before setting the
AppEngine OffScan. When you set an AppEngine OffScan, all of its hosted objects are automatically set OffScan.

To set an ApplicationObject OffScan
1. Select the object in the console tree.1.

2. In the details pane, right-click the ScanStateCmd attribute and click Modify. The Modify Boolean Value2.
dialog box appears.

3. Assuming the current value is True (OnScan), click the False option button, click Apply and then click OK.3.

Note that the ScanState attribute’s value in the details pane remains True (OnScan).

4. To update the attribute value to False, select it.4.
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